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NEW QUESTION 1
- (Exam Topic 1)
You need to roll back the mobile app to an earlier version.

What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

Requirement Action

Identify the currently published version and view version notes. [l

\View the session details page for the app in Power Apps Studio.
[View environment details for the app in the Power Admin portal.
i‘u"“lew details for the app in the Power Apps Maker portal.

Revert to an earlier version of the app.

!Selecl Restore on the previous version of the app.
|Export the previous version of the app and import as a new version.
IDejete versions of the app until the desired version is the most recent.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Box 1: View the sessions details page for the app in Power Apps Studio

Use PowerApps Studio, select the App, and choose and you will be directed to the app’s Versions tab in PowerApps portal. There should be one version marked
Live.

Detalls - Share - Versions . Settings

HowerApps ieeps a versaon h SO0y of YORIT 3005

i |
VERSION MODIFIED MODIFIED BY POWERAPPS RELEASE 'i_:_; PUBLISHED COMMENT

i 6/7/2017 9:01:43 AM Karthik Bharathy 2.0.659 [ Live ]

Box 2: Select Restore on the previous version of the app. Restore an app from your account

> Open powerapps.com, and then click or tap Apps in the left navigation bar.

> Near the right edge, click or tap the info icon for the app that you want to restore.

> Click or tap the Versions tab, and then click or tap Restore for the version that you want to restore.

Details « Share . Versions « Settings « Analytics (preview)

PowsrApps keeps 3 version history of your 3pps
VERSION MODIFIED MODIFIED BY POWERAPPS RELEASE @ PUBLISHED COMMENT
2 §/20/2018 2:24:29PM  Firstname Lastname  3.18081.19

1 7/9/2018 10:55:48 AM  Firstname LastName 3.18071.36 Delete

Reference:
https://powerapps.microsoft.com/sk-sk/blog/saveandpublish/ https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/restore-an-app

NEW QUESTION 2

- (Exam Topic 1)

You need to ensure that the app can support the needs of User2 and User3, and meets the production deployment requirements.

Which tools should you use? To answer, select the appropriate tool in the answer area. NOTE: Each correct selection is worth one point.

Tools Answer Area
Solution Checker Requirement Tool
App Checker Accessibility

Object Detector
Deployment

Preview the app
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: App Checker

Scenario: Several sales representatives have accessibility restrictions. User2 is visually impaired and cannot see images. User3 is unable to use a mouse.
Users who have vision, hearing, or other impairments can use your canvas app more easily and successfully if you consider accessibility as you design how the
app looks and behaves. If you're not sure how to make your app more accessible, you can run the AppChecker Accessibility checker in Power Apps Studio.
Box 2: Solution Checker

Scenario: Before deploying the app to production, you must ensure that the app conforms to Microsoft accessibility and performance guidelines.

Use solution checker to validate your model-driven apps in Power Apps. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/accessibility-checker https://docs.microsoft.com/en-us/powerapps/maker/common-data-
service/use-powerapps-checker

NEW QUESTION 3
- (Exam Topic 1)
You need to provide the app to Tailwind Traders. What should you do?

A. Within Managed Properties, set the value of the Allow customizations option to tru
B. Export the app as a managed solution.

C. Use the Share App feature.

D. Within Managed Properties, set the value of the Allow customizations option to fals
E. Export the app as a managed solution.

F. Within Managed Properties, set the value of the Allow customizations option to fals
G. Export the app as an unmanaged solution.

Answer: C

Explanation:

Scenario: The completed app and all supporting components must be provided to Tailwind Traders. Tailwind Traders must not be able to make changes to any of
the components.

Managed Solution: A managed solution is a finalized solution that can be distributed and installed. They are created by exporting an unmanaged solution by setting
restrictions to prevent any further customizations. The whole point of Managed is locking down the Component states so they cannot be edited. Deleting the
Managed Solution will remove all its customisations as well as data contained. Managed Solutions become read only once deployed so they cannot be
manipulated.

Reference:

https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-1SV/Managed-vs-Unmanaged/td-p/495685

NEW QUESTION 4
- (Exam Topic 2)
You need to implement logic in the app for lost sales. What should you do?

A. Create a business process flow.

B. Define a business rule for the Sales Log edit form.

C. Set the required field property of the Won/Lost field to Required.

D. Create a formula for the Description field that uses the Update function.

Answer: B

Explanation:
Scenario: Requests for quotes are currently stored in a Sales Log workbook. The workbook includes the following information:

> Status of the Request for Quote (RFQ) with the values of Won, Lost, No Bid, and Cancelled Salespeople often do not set status of RFQs in the Sales Log to
Won when a sale is closed and the customer

purchase order is received.

You can create business rules and recommendations to apply logic and validations without writing code or creating plug-ins. Business rules provide a simple
interface to implement and maintain fast-changing and commonly used rules.

Business rules defined for an entity apply to both canvas apps and model-driven apps if the entity is used in the app.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-business-rule

NEW QUESTION 5

- (Exam Topic 3)

You are creating an app for an organization’s human resources (HR) department. You create an Employee entity in an unmanaged Common Data Service
solution.

Another user creates the following Power Automate flows separately from the solution:

 Flow Description |
Send email to the HR manager when a new document is uploaded to

FlowA . .

| Microsoft SharePoint. m— |

Send email to the HR manager after a user selects a document in Microsoft

Flowa OneDrive for Business and runs the flow.

Send email to the HR manager at 8 AM daily if new documents are
FlowC ) L : 3 : ;

uploaded in Microsoft OneDrive for Business since the previous day.
FlowD Send email to the HR manager when a new employee record is added.

You need to incorporate the flows that can be added to the solution.
Which two flows can you include? Each correct selection presents a complete solution.
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NOTE: Each correct selection is worth one point.
A. FlowA

B. FlowB

C. FlowC

D. FlowD

Answer: AD

Explanation:
You can add any of these conditions to determine precisely when your flow is triggered.

When a record is created, updated or deleted

*Trigger condition Choose an option or add your own

. : Cr
*The entity name Sk

Create or Delete
*Scope .
Create or Update

, . : ; Craate of Update or Delete
Show advanced options
Delete

Update

Update or Delete

Enter custom value

Reference:
https://docs.microsoft.com/en-us/power-automate/connection-cds-native

NEW QUESTION 6

- (Exam Topic 3)

You are creating a model-driven app that allows users to create and edit a list of existing accounts. You need to display a list of all active accounts.
Which user interface components should you use?

A. view

B. gallery

C. data table
D. form

Answer: C

Explanation:

Imagine that you have a collection of data (such as a list sales orders, a set of service tickets, or a directory of contacts), and that you want to show this data in
your Microsoft PowerApps app in a tabular format, where each column represents a field and each row represents a record. In the past, you might have been able
to roughly simulate this visualization, although the process required some effort. However, we’ve been listening to your requests and are happy to announce that
you can now quickly and easily achieve this very typical visualization by using the new Data table control that has been recently added to PowerApps.

Reference:

https://powerapps.microsoft.com/fr-fr/blog/introducing-the-data-table-control/

NEW QUESTION 7

- (Exam Topic 3)

You are configuring a new Common Data Service environment by using the Power Apps Maker portal. You need to create an entity that uses the prefix xyz.
Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

Actions Answer Area

| Create an entity in the new solution.
Enter the entity Display Name and use the existing prefix.

.Adl.:i a new solution.

|Enter the entity Display Name and modify the prefix to xyz.

'Add a hmuﬁ blisher with th e_[::ref'ix XyZ

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
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https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-entity

NEW QUESTION 8

- (Exam Topic 3)

You plan to create apps for a company.

You need to identify the Power Platform tools required.

What should you use? To answer, drag the appropriate tools to the correct requirements. Each tool may be used once, more than once, or not at all. You may
need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Tools Answer Area

Power Virtual Agents bot Requirement Tool
Create an app with a customized user interface that

Power Automate allows users to quickly create support tickets.

Canvas app Create an app that uses a guided business process to

navigate through all records associated with a support
ticket.

Send an email 1o a customer support manager every time
a support ticket is created.

Model-driven app

Create an automated chat tool that guides a customer
through the support ticket creation process.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Canvas App

Box 2: Model-driven app

Model-driven app design is a component-focused approach to app development. Model-driven app design doesn’t require code and the apps you make can be
simple or very complex. Unlike canvas app development where the designer has complete control over app layout, with model-driven apps much of the layout is
determined for you and largely designated by the components you add to the app.

Box 3: Power Automate

Power Automate is a service that helps you create automated workflows between your favorite apps and services to synchronize files, get notifications, collect
data, and more.

Box 4: Power Virtual Agents bot

When you create bots with Power Virtual Agents, you author and edit topics.

NEW QUESTION 9

- (Exam Topic 3)

You are an app builder for a medical office. The medical office uses activities to book appointments and business process flows to track patient status. The
cleaning staff wants the app to connect directly to a Microsoft Excel workbook to track cleaning tasks. The office does not have access to reporting tools including
Power BI.

You need to create apps for the following groups of users. Apps must not require customizations or the use of additional products.

Groups Comments | Requirements
. Users will access the app only from | Users must be able to access contacts and
Reception area staff SEy 3 - S
I desktop devices in the office. | display activities as a doughnut chart.
| ; Users will access the app from tablet | Users must be able to access activities and
Medical staff : ;
devices. : _— | business process flows. S
: Users will access the app only from | Users must be able to interact with a checklist
Cleaning staff . ; ;
| mobile phone devices. | to mark cleaning tasks as completed.

Which type of app should you build for each group? To answer, drag the appropriate app types to the correct groups. Each app type may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

App types Answer Area
Canvas app Group App type

Model-driven app Reception area staff

Embedded canvas app Medical staff

Cleaning staff

A. Mastered
B. Not Mastered

Answer: A
Explanation:

Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/embedded-canvas-app-guidelines https://global.hitachi-solutions.com/blog/canvas-vs-
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model-driven-apps

NEW QUESTION 10

- (Exam Topic 3)

A company has a Common Data Service custom entity that stores customer account data. You need to create a relationship between the custom entity and the
Account entity. Which two tools can you use? Each correct answer presents a complete solution.

NOTE: Each correct selection is worth one point.

A. Power Platform Admin center

B. Power Apps solution explorer

C. Power Apps Maker portal

D. SQL Server Management Studio
E. Visual Studio Code

Answer: BC

Explanation:
There are two designers you can use to create and edit 1:N (one-to-many) or N:1 (many-to-one) relationships:

> You can create and edit 1:N (one-to-many) or N:1 (many-to-one) entity relationships in Power Apps portal

> You can create and edit create and edit 1:N (one-to-many) or N:1 (many-to-one) entity relationships using solution explorer
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/create-edit-1n-relationships

NEW QUESTION 10

- (Exam Topic 3)

You need to set the value for a global variable named RunningTotal to 5 and navigate to the previous screen nhamed MainScreen.
Which formula should you use?

A. UpdateContext( { RunningTotal: 5 } ); Navigate( MainScreen, ScreenTransition.Cover, RunningTotal );
B. If( Value(TextBox1.Text) >= 0, (Set( RunningTotal, 5); Back();), Color.Green )

C. UpdateContext( { RunningTotal:5 } ); Back()

D. Set( RunningTotal, 5 ); Back();

Answer: D

Explanation:

You set the value of the global variable with the Set function. Set( MyVar, 1) sets the global variable MyVar to a value of 1.

Use the Back and Navigate function to change which screen is displayed. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/working-with-variables https://docs.microsoft.com/en-us/powerapps/maker/canvas-

apps/functions/function-navigate

NEW QUESTION 14

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are creating a canvas app that displays a list of accounts.

Users must be able to select an account and view details for the account. The app must include a feature that brings the user back to the list of accounts.
You add a blank screen named Screen_Accounts and add a gallery named Gallery_Accounts to the screen. You set the data source of Gallery_Accounts to
Accounts and add another blank screen named Screen_AccountDetalil.

You need to complete the app. Solution:

> Add an edit form to Screen_AccountDetail and set the Default Mode of the form to New
> Set the OnSelect property of Gallery_Accounts to Navigate(Screen_AccountDetail).

> Set the data source of the form to Accounts.

> Set the Item property of the form to Selected.

> Add a back icon on Screen_AccountDetail and set its OnSelect property to Navigate(Screen_Accounts).
Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation:

FormMode.New: the form is populated with default values and the user can modify the values of the fields. Once complete, the user can add the record to the data
source.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-form

NEW QUESTION 15

- (Exam Topic 3)

You are an app maker. You are creating a canvas app. You do not have access to Power BI.

You need to add charts to the app.

Which three chart types can you add directly to the canvas app? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

Passing Certification Exams Made Easy visit - https://www.surepassexam.com



\l;/ Exam Recommend!! Get the Full PL-100 dumps in VCE and PDF From SurePassExam
L' Sure PHSS https://www.surepassexam.com/PL-100-exam-dumps.html (153 New Questions)

A. pie

B. area
C. funnel
D. column
E. line

Answer: ADE

Explanation:

You can use line charts, pie charts, and bar charts to display your data in a canvas app. Add a bar chart to display your data:
* 1. On the Home tab, add a screen.

* 2. On the Insert tab, select Charts, and then select Column Chart. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/use-line-pie-bar-chart

NEW QUESTION 20

- (Exam Topic 3)

You are an app maker.

You want to create apps and track customizations as part of the default solution. You need to determine the impact of performing the work in the default solution.
What should you conclude?

A. The default solution does not contain all components and customizations from all solutions in the environment.
B. The prefix used when creating components as part of the default solution can be set to a specific value.
C. The default solution cannot be exported and distributed to another environment.

Answer: C

Explanation:

Default Solution. This is a special solution that contains all components in the system. The default solution is useful for discovering all the components and
configurations in your system.

Why you shouldn't use the default solutions to manage customizations

There are a few reasons why you shouldn't create apps and make customizations in either of the default solutions:

> The default solution can't be exported; therefore, you can't distribute the default solution to another

environment.

The default solution contains all components and customizations from all solutions in the environment.

By default, all enabled users can create apps and customize components in the Common Data Services Default Solution.

It's difficult to locate or identify the customizations you've made in the environment by using either default solution.

When you use either default solution to create components, you'll also use the default publisher assigned to the solution. This often results in the wrong publisher
prefix being applied to some components.

Reference:

https://docs.microsoft.com/en-us/power-platform/alm/use-solutions-for-your-customizations

NEW QUESTION 23

- (Exam Topic 3)

You create an app with multiple screens.

Test users report that the size and type of gallery displayed on each screen are different. You must improve the consistency for the app screens.

You need to create a reusable gallery that displays information based on the current record.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

NOTE: More than one order of answer choices is correct. You will receive credit for any of the correct orders you select.

Actions Answer Area

Add a gallery control
Add an input property.
Create a component
Add a screen.

Create a form

Add an output property.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Add a gallery control Add a gallery to a blank screen

* 1. On the Insert tab, select Gallery, and then select Vertical.

* 2. On the Properties tab of the right-hand pane, open the Items list, and then select your Gallery Step 2: Add a screen
Add a gallery in a screen

* 1. On the Home tab, select New screen > List screen.

A screen that contains a Gallery control and other controls, such as a search bar, appears. Step 3: Add an input property
Input property is how a component receives data to be used in the component. Reference:
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https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-gallery https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/create-component

NEW QUESTION 24
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